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About this lab 

This Laboratory session is designed to familiarize you with Windows 8 and Office 2013.  

We will take you through typical administrative tasks of managing Windows 8 settings, 
customizing the Start Screen, and reviewing new features.  We will also manage some of the 
new features of Office 2013 and related components. 

This laboratory is targeted for the desktop administrator, and assumes that the participant has 
general experience with desktop operating systems, Active Directory, and Group Policy 
technologies.  While relevant experience is helpful, it is not required to complete the lab 
exercises. 
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About the Laboratory Environment 

You will be working in teams of two, sharing a workstation between members.  The workstation 
has been configured with Windows 2008 R2 Hyper-V in order to house the virtual computers 
required for this lab.   

We have configured two virtual machines as follows: 

¶ HANDS7a-DC:  A Windows 2012 Server, Microsoft Exchange 2013, Active Directory, and 
DNS installed.    

¶ HANDS7a-WIN8:  A Windows 8 64 Bit client joined to the Active Directory domain.   Office 
2013 Professional Plus is installed. 

Both virtual machines have been setup in the ILTA2013.local domain and exist on the same 
network. 

Notes:   

¶ You should use the administrator account for the laboratory tasks, except where noted. Its 
password is password. 

¶ Two typical users have also been setup: iltauser1 and iltauser2.  Their passwords are 
password. 

¶ DO NOT USE THE CTRL-ALT-DEL KEY SEQUENCE, AS IT WILL DISRUPT YOUR VIRTUAL 
SERVER SESSION.  You should use the CTRL-ALT-END key sequence instead.  You may also 

use the CTRL – ALT – DEL button   in the Hyper-V session console as well. 
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 Lab 1: Windows 8 ï Navigating the User Interface 

One of the most notable changes to Windows 8 is the introduction of the Start Screen as a 

replacement to the familiar Start Button & Menu.  The Start Screen embraces a new Modern 

User Interface from which Windows 8 Applications are executed. While the modern UI has been 

developed and optimized for touch, traditional keyboard & mouse support is included as well. 

:  Improvements have been made to better support 
users who prefer a mouse and keyboard experience to access applications.                                                                                                                                  

In this lab we will walk through following new UI features available on Windows 8. 

¶ Start Screen 

¶ Live Tiles 

¶ Program Groups 

¶ Hot Corners / Edge UI 

Exercise 1:  Review new Start Screen 
In this exercise, we will access the Start Screen and review the many features that are included 

in the new Modern UI.  

1) Windows 8 features a lock screen that supports notifications that can give you up to date 
information on the system.  By default, we can see the current date and time, as well as the network 
interface status. To log into the workstation: 

¶ Keyboard: Type Ctrl + Alt + End 

¶ Mouse: Click the background, hold and Drag upwards on the opening screen to access the 
logon Prompt 

2) At the logon screen, make sure the Administrator account is chosen. Type in password, but do not 
click Enter yet.  You will notice that there is an icon the looks like an eye next to your password.  This 
is a new feature on Windows 8 called “Password Reveal”.  If you click and hold the icon, you will see 
the password in clear text.  This can often be helpful in troubleshooting users logging into the 
system.  This feature can also be disabled via Group Policy in environments where demands on 
security are higher. 

NOTE: Windows 8 has provided additional sign-in options allowing you to authenticate via 
Smartcards, Biometric readers, Picture Passwords and 4-digit PINs. 

3) Type Enter or click the purple arrow to initiate login. 
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4) You should now be presented with the Windows 8 start screen.  You should notice that this 
interface looks dramatically than the start menu of previous windows operating systems.  Some of 
the major changes include: 

¶ Live Tiles – Customizable tiles that can dynamically update content depending on the 
features of the underlying application. 

¶ Program Groups  -- You can group and organize tiles to offer a personalized view of the 
interface 

¶ Hot Corners – You can quickly access common functions by moving the mouse to the four 
corners of the desktop to reveal the left and right Edge UI. 

o Right Edge UI > Charms Bar – By moving the mouse to the lower right or upper right 
corners, you can access the charms bar.  This context sensitive menu provides quick 
access to certain system features including; Search, Sharing, Start, Devices & 
Settings. 

o Left Edge UI > Running Programs – By moving the mouse to the lower left or upper 
right corners and then dragging the mouse upward or downward you can bring up 
thumbnails images of running programs. (NOTE: you will not have this option until 
you have a running program later in the lab). 

: Try leaving the cursor in the bottom left corner and click to quickly access the 
Start Screen and the top left corner to access the next application (equivalent to 
Alt+Tab in previous Windows releases) 

 

Exercise 2:  Working with Live Tiles and Program Groups  
Windows 8 live tiles are interactive applications that may offer live updates to modern style 

applications.  They can provide instantaneous information to dynamic data such as news, 

weather, or firm intranet updates.  In this exercise, we will customize and navigate through 

some of the live tile features.  

1) By default, Microsoft displays a number of new Windows 8 style applications that demonstrate 
some of the capabilities of live tiles.  For example: 

¶ The Finance application will cycle through the days stock numbers 

¶ The Bing news application will cycle through the day’s news 

¶ The Travel application will cycle through pictures of places you would rather be. 
 

For now, we will focus on the Sports application. 
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2) Right Click on the Sports application (look for the trophy icon), and note that a settings dialog will 
appear from the bottom of the screen.  Adjust the Tile Size by clicking the Smaller button. 

3) You can turn off the live tile updates by Right Clicking the Sports application, and choosing the Turn 
Live Tile Off button. You will now notice that the live tile graphic will turn into a trophy, and no 
longer update. 

4) You can also change the order of the live tiles. Left Click and hold the sports application, and drag it 
to the top of the column. You should see the other icons adjust around the application. 

5) The Start Screen is organized in Program Groups, which are simply collections of tiles.  The Start 
Screen also expands so that it may be larger than the screen may display.  Moving your mouse 
cursor to the bottom of the screen will display a scroll bar that you can drag to the left or right. You 
can also use the right and left arrow keys to move accordingly as well.  

6) You can drag icons away and create custom Program Groups on the Start Screen. Click and hold the 
Finance Icon in the Start Screen and drag to empty part of Screen. Notice that it starts a new 
column and the previous location rearranges the icons accordingly. Release the Icon and a new 
Program Group will be created. 

7) Drag Sports near Finance. The icons should cluster together. Now drag Photos over near the new 
grouping with Sports and Finance. You’ve now just created a new Program Group on the Start 
Screen. We can also set a new name for the group as well.  

8) To name the group, press and hold the Control Key, followed by typing and releasing the Minus 
key (or click the minus sign in the bottom right corner of the Start Screen). Your view will now zoom 
out to a 10,000 ft. view with all of the Start Screen icons appearing much smaller, but the entire 
Start Screen in view.           

: Manually naming program groups can now be done from the Start 
Screen by holding CTRL and right clicking any program group.  No need to break out the reading 
glasses!                                                                                                                                  

9) Right click on the new program group you’ve created and you will see a prompt in the lower left 
portion of your screen. It will prompt to Name Group. Set a name of ILTA 2013 and click, or type 
Enter, on the OK button to confirm the change. 

10) Type the Windows Key, or click on any open space on the Start Screen and you will be dropped 
back to the normal view.  

11) Using your mouse on the bottom scroll bar, or using your arrow keys to go right, if you navigate to 
your new program group, you will see the grouping with the name set on top of the Program 
Group. 

: The Start Screen and program groups can now be controlled through 
Group Policy. 
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Exercise 3:  Windows 8 Charms and Searching 
Windows 8 Charms allow you quick access to common actions and features around the OS. The 

Charms Bar is context aware, meaning that accessible functions change based on the 

application you are running. 

In the following exercise, we will demonstrate this feature by switching from the Default Search 

Context of local Files, Applications, and Settings and switch to Internet Explorer. When you 

switch to Internet Explorer, it will execute the search in Bing and return results in Bing Search 

format. 

1) Charms Bar – To work with the Charms Bar, you can either hold the Windows Key + C or move the 
mouse cursor to the upper or lower right hand corners of the screen. The Charms Bar will then 
appear from the right hand side of the screen, and will overlay any running Applications or 
Programs. You will have access to the following: 

¶ Search – Search files, applications, settings, even the Internet 

¶ Share – Share to your Social Media connections, if allowed access on your Intranet 

¶ Start – Alternate access to the Start Screen from any Application or Program 

¶ Devices – Display connected devices like printers, scanners, and MFP’s 

¶ Settings – Access the Control Panel, Personalization, PC Info, Notifications or even to shut 
down or restart the machine 

2) Windows Search – This function has been enhanced to work in many contexts. Under the Search 
Bar, you have different classes that you can search. Clicking one will change the context of the 
search which will we now review.  

You can search Apps, Settings, and Files by default. You can also change the context to Internet 
Explorer, or other Windows 8 Applications that utilize Search functionality. Netflix, for example, not 
included in the lab, provides a search function to search TV Shows using the Search Charm feature 
from Windows 8.  

: The search charm has been reengineered to automatically search 

Everywhere including your PC, cloud and the internet -- so that you no longer have to select the 
context (Apps, Settings or Files) in which to search.  Searching within modern Windows 8 apps has 
been moved to a search box control within each app. 

a. Access the Charms Bar either with your mouse or keyboard and select the Search option. 

b. Type Power with the Search Context set to Apps; you will see results for PowerPoint as well 
as PowerShell based on the άtƻǿŜǊέ keyword. 

c. Select Internet Explorer in the list below Apps, Settings, and Files. You have now changed 
the context of the search from Applications to the Internet 
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d. You will then be presented search results from Bing on the keyword Power to the left hand 
side of the Screen in the Windows 8 Application version of Internet Explorer 10.  

e. Change the context over to Settings, and you will now see options to manage Power 
Management features from the Control Panel 

3) Windows Settings – Easily access various settings in the Control Panel such as Installed Programs, 
Keyboard and Mouse Settings, even Shut Down and Restart your PC. In the following, we will work 
with available settings for the Start Screen.  

a. Access the Start Screen with your method of choice and then open the Charms Bar with the 
Start Screen still in view. Click Settings icon in the Charms Bar. 

b. You will notice the following icons on the lower left portion of the Settings Bar 

¶ Tiles Menu Options (Upper Right) – Manage tile settings for the Start Screen 

¶ Network Connection Name (Lower Right) ς If connected to LAN, it will show your 
current connection and what it is named. If it were a Wi-Fi connection, you would go 
here to view available Access Points to connect.  

¶ Volume Control (Lower Right) ς Shows current audio volume level 

¶ Brightness (Lower Right) ς Control screen brightness (Available on Laptops Only) 

¶ Notifications (Lower Right) ς Hide notifications for 1, 4, or 8 hours 

¶ Power (Lower Right) ς Sleep, Shut Down, Restart. (Update and Restart only if updates 
are available for install) 

¶ Change PC Settings (Lower Right) – Configure Background images, Devices, Search 
Applications, etc. 

c. Select the Tiles menu option that appears on the upper right portion of the Settings Bar. 
You will have an option to toggle from Yes to No (currently set to No) whether or not you 
want the Administrative Tools to be added to the Start Screen as a Program Group. Click the 
slider bar to change the setting. The click will then change the option to Yes. 

d. Navigate back to the Start Screen by typing the Escape Key and then scroll over to the far 
right portion of your Start Screen. You will see a new Program Grouping with your 
Administrative Tools. This could be really handy for your support staff to have easier access 
to common tools to help troubleshoot issues without digging through Settings or going into 
the Control Panel. 

4) All Applications View – Like the Start Menu of previous versions, the Start Screen provides access to 
all installed applications and programs that are on the local machine. This is helpful in accessing an 
application that is not pinned to the initial Start Screen.  
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a. Type the Windows Key to access the Start Screen, or access the icons via the Charms Bar. 
Right click any blank area on the Start Screen and the All Apps icon presents in the lower 
right hand portion of the Start Screen as shown below.  

: The “All Apps” view can now be brought up by swiping 
downward from the Start Screen or clicking the down arrow in the lower left corner. 

b. By selecting the All Apps icon, you will now see all installed applications and programs that 
are local to the VM. This is what would historically have been the All Programs Menu in 
Windows 7 and the Programs Folder in Windows XP. 

c. As you can in the first Start Screen, you can move your mouse cursor to the bottom of the 
screen, or use your arrow keys to move left or right through the various application icons.  

d. The first groups of icons on the left that are displayed are your Windows 8 Applications. The 
next groups of icons to the right are all classic programs that  

 

Exercise 4:  Working With Windows 8 Applications  
With this release, Microsoft introduces the new Windows Runtime (WinRT) environment for 

executing modern-style applications that are optimized for the enhanced user interface and 

touch screen operation native to Windows 8.  The new applications will often support Live Tile 

features, context searching, and a better experience when used on tablet platforms.  A Windows 

8 app store has also been introduced to facilitate the installation and maintenance of these 

applications across multiple devices in the cloud. 

Along with the WinRT environment, Windows 8 Professional and Enterprise Editions still support 

running ŜȄƛǎǘƛƴƎ όƭŜƎŀŎȅύ ŀǇǇƭƛŎŀǘƛƻƴǎ ǘƘǊƻǳƎƘ ǘƘŜ ǳǎŜ ƻŦ ŀ ά5ŜǎƪǘƻǇ aƻŘŜέ ƛƴǘŜǊŦŀŎŜΦ  Lƴ 

general, applications that run on previous versions of Windows will run in this Desktop interface, 

which mimics the look and feel of Windows 7. 

In this exercise, we will take a closer look at Windows 8 style applications, take a look at 

Desktop mode, and see how these platforms work together. 

1) By default, Windows 8 includes many new modern style applications, such as Maps, Mail, People, 
Calendar, Sports, and BING.  In addition, hundreds of additional applications can be added and 
downloaded from the Windows Store App.  Find and launch the Weather application by clicking on 
it. 

: Feeling bored with this lab? Check out the Windows Store by launching it from the Start 
Screen, then bring up the charms bar by accessing the upper or lower right hot corners and select 
search. Try to install Angry Birds, Twitter (@ILTAConf), Facebook, Temple Run or whatever time 
waster you prefer (you may not be able to without a Microsoft account, but you get the idea) – now 
how do we stop your end users from doing this? Stay tuned… 
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2) Once the weather application launches, allow the location awareness prompt, and notice that 
traditional menu screens and toolbars are not shown, and the application takes full screen by 
default.  To get to the options and settings of Windows 8 applications, Right Click anywhere in the 
application to access the context menu. 

3) Windows 8 applications have been designed to work well with multitasking.  To see the new 
enhancements, let’s go back to the start screen, and launch the Finance App.  To do so, use the 
charms bar, the lower left hot corner, or the Windows key on the keyboard.  Launch the Finance 
App by clicking on it, or by typing in “CƛƴŀƴŎŜέ on the keyboard.  Typing a phrase in the start screen 
will automatically search for the application. 

4) The Finance application will now launch, while the Weather application is running in the 
background.  You can view active applications by doing the following: 

¶ Mouse:  Go to the upper left hand hot corner.  The previously used application should 
appear as you move the mouse downwards, hugging the left hand side, you will see all of 
the open applications. 

¶ Keyboard:  Use ALT-TAB to cycle through open applications 

5) To run Windows 8 applications side by side, go to the upper left hot corner, and bring up the left 
edge UI by moving the cursor downwards.  “Grab” an application, and drag it slightly to the right.  
When a column appears, you can “drop” the application to a side of the screen.  Feel free to move 
the column to resize the applications.  Also note that the look and feel of the application may 
change, depending on the position of the column slider.  Don’t worry if you can’t do it on the first try 
– It takes practice! Try to split your desktop with a Windows 8 app?  THIS WILL NOT WORK AT THE 
CURRENT RESOLUTION IN THE LAB. 1366 x 768 or greater is required. 

: Snap sizing is now more flexible and is not limited to 70/30 splits, 
rather applications can be split 70/30, 60/40 or 50/50 – with larger monitors (or multiple monitors) 
you may even be able to split up to four apps. 

6) To close an application, click and hold the top middle of the application – the cursor will change to a 
hand -- drag downwards to the bottom of the screen and release.  You may also use the popular 
ALT-F4 command to close an application. 

7) Legacy applications will launch in Desktop Mode.  Go to the Start Screen, and launch Word 2013 by 
clicking on it, or typing in Word 2013, and clicking that application. 

: The ability to boot directly to Desktop mode has been added back 
into Windows 8.1. 

8) Click the Word Restore button (between the minimize and exit buttons in the upper right hand side) 
and notice that the desktop now looks like Windows 7, sans start menu.  This mode is actually a 
Windows 8 application, but is designed for the Windows 7 interface for those applications that have 
been not been optimized for the Windows 8 user interface.    

9) Click and hold the top middle of the desktop, and drag it down to close it. 
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10) Don’t worry, you haven’t actually closed the desktop, because you cannot close it Windows 8.  To go 
back to Desktop mode, click on Desktop on the Start Screen, type Windows key + D, or type in 
Desktop on the start screen. 

 : Look, the start button is back in its rightful place in desktop mode! 
Wait – but when you click -- it just puts you back out to the new Start Screen.  

11) To actually close Word, use the typical exit X button on the upper right hand of the dialog, or click 
Alt-F4. 
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Lab 2: Windows 8 Group Policy Management 

Many components of Windows 8 are managed through the use of Group Policy.  Several new 

policies have been created specifically to manage the new aspects and features of Windows 8.  

Additionally, the Group Policy architecture has been enhanced to give the administrator better 

options of deploying and controlling policies. 

Similar to Windows 7, policies can be created and modified via the Group Policy Management 

Console.  We have installed this in our workstation as part of the Remote Server Administration 

Tools for Windows 8.  You should be aware that Windows 8 policies should generally be 

managed by a Windows 8 or Server 2012 operating system.  In the following lab, we will use 

Group Policy to control certain Windows 8 features, as well as to customize the user interface.   

 

Exercise 1:  Disable Access to a Windows 8 Start Screen App 
bƻǿ ǘƘŀǘ ȅƻǳΩǾŜ ŎŀǳƎƘǘ ǳǇ ƻƴ ŀƭƭ ǘƘŜ ǘǿŜŜǘǎ ŦǊƻƳ ǘƘƛǎ ȅŜŀǊΩǎ L[¢! ŎƻƴŦŜǊŜƴŎŜΣ ƛǘΩǎ ǘƛƳŜ ǘƻ ǎǉǳŀǎƘ 

the outbreak of end user un-productivity.  5ŜǇŜƴŘƛƴƎ ƻƴ ȅƻǳǊ ǊŜǎǇŜŎǘƛǾŜ CƛǊƳΩǎ L¢ ǇƻƭƛŎƛŜǎΣ ȅƻǳ 

may wish to deny complete access to the Windows Store or prevent a single application from 

running. 

First, we will disable access to a single Windows 8 application using AppLocker, a feature of 

Windows 8 Enterprise.  AppLocker was first introduced in Windows 7, as a replacement to 

Software Restriction Policies, that allows you to specify which users or groups can run particular 

applications in your organization. 

1) Before we can enable AppLocker, we need to start the Windows 8 Service responsible for 

enforcing policy. 

a. From the Start Screen type “services.msc” and launch “Services” 

b. Look for the Application Identity Service, right click and select Start. 

2) For this example we are going to be using local policy to enforce AppLocker – the rest of the 

examples in this Lab will use domain policy objects. 

a. From the Start Screen type “gpedit.msc” and launch “Local Computer Policy Editor” 

b. Expand Computer Configuration > Windows Settings > Security Settings > Application 

Control Policies > AppLocker 

c. Select “Packaged app Rules” 

3) Once configured, AppLocker by default will block all applications that do not have an “allow” 

rule specified – for this reason, we first want to “whitelist” all Windows 8 apps in our 

environment. 

a. Right-click “Packaged app Rules” and select “Create Default Rules” 
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b. You will see a rule created that Allows “All Signed Packaged Apps” to run for Eveyryone. 

4) Now that we have our default rule, we need to create a Deny rule for our offending application, 

in this example, let’s block Xbox Games. 

a. Right-click “Packaged app Rules” and select “Create New Rule” 

b. Click Next 

c. Change the Action to Deny and click Next 

d. Make sure “Use an installed packaged app as a reference” is selected and click “Select” 

e. Place check marks next to the Games app. 

f. Click Create 

 

5) Return to the Start Screen, locate the Games app tile (looks like an Xbox controller) – or type it 

into search.  Good luck trying to escape from that giant demon monkey now. 

 

Exercise 2:  Disable Access to the Windows Store  
Now ǘƘŀǘ ǿŜΩǾŜ ƳŀŘŜ ƛǘ ƘŀǊŘŜǊ ŦƻǊ ŜǾŜǊȅƻƴŜ ǘƻ ƎŜǘ ŘƛǎǘǊŀŎǘŜŘ ƛƴ ǘƘŜ DŀƳŜǎ ŀǇǇ ŀƴŘ ŜŀǎƛŜǊ ǘƻ 

ŦƻŎǳǎ ƻƴ ǿƻǊƪ ŀƭƭ ŘŀȅΣ ǿŜΩƭƭ ŘŜǎǘǊƻȅ ǘƘŜ ƭŀǎǘ ǎƘǊŜŘ ƻŦ ƘƻǇŜ ǘƘŜȅ ƘŀǾŜ at procrastination by 

disabling access to the entire Windows Store all together. 
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1) Find the group policy management console on the Start Screen and launch it.  If you can’t find it, you 
can always search for it by typing in “Group policy”, and then clicking on the application.   You will 
notice that the application will launch in Desktop Mode, as it is not a Windows 8 Application.  

2) Navigate to the OU where our Windows 8 workstation lives.  Expand to the Forest: ILTA2013.LOCAL 
> Domains > ILTA2013.LOCAL > ILTA2013 Workstations node. 

3) We have already created two Group Policies for this lab.  Right click on the Windows 8 Desktop 
Policy and select Edit 

4) Navigate to  Computer Configuration > Policies > Administrative Templates > Windows 
Components > Store 

5) Double click Turn Off Store Application to access and edit the policy setting. 

6) Set policy to Enabled 

7) Click OK 

8) Now we have to refresh Group Policy on the machine.   

One of the new features of Windows 8 / Server 2012 management 
allows you to force a group policy refresh for all computer objects in an OU remotely from the 
console, instead of waiting for the policy refresh interval.   To do this, from the Group Policy 
Management Console, right click on the ILTA2013 Workstations OU, and in the context menu that 
appears, Select Group Policy Update. Click Yes to initiate the refresh. 

9) You will see a dialog window with the machine name(s) that the job was sent to, as well as a 
grouping based on Success or Failed Status of GPMC being able to connect to the machine and 
setting the job.  Note that our Hands7a-Win8 PC is in the list. 

10) If Successful, give your Win8 VM a few minutes to run the task. A black window will appear in your 
session, which will have a message stating it is processing Computer Policy, then User Policy, and 
then finally should close on its own. This is the process that updates your policy. 

11) After you see that black box open and finally close, access the Start Screen via mouse or keyboard. 

NOTE: Remote Group Policy Update relies on a scheduled task running on the machine and can take 
up to 10 minutes. If you want to force policy refresh, from Windows + x keys, select Comand Prompt 
(Administrator), select Yes to UAC and run gupdate /force from the command line. 

12) Attempt to access Store, via mouse or keyboard 

13) You should then see a message stating that the access to the Store has been blocked and to contact 
the System Administrator.  

NOTE: Blocking access to the Windows Store does not preclude you from installing custom 

applications that are developed internally with Visual Studio for Windows 8 Applications, which 

will be reviewed at a later time.  
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Exercise 3:  Control IE Settings 
Internet Explorer 10 comes pre-installed in Windows 8 but as two separate variations.  Internet 

Explorer refers to the variation of IE optimized for a touch interface and which runs without any 

Add-ons, Internet Explorer for the desktop refers to the traditional IE variation you know and 

love.   

: IE 11 comes pre-installed on Windows 8.1. 

Here we will manage some of the settings associated with using the two variations of IE on 

Windows 8 including configuring the variation to use when opening links and start screen tile 

behavior. 

[ŜǘΩǎ ŦƛǊǎǘ ƭƻƻƪ ŀǘ the problems with running a website that requires an Add-on through Internet 

9ȄǇƭƻǊŜǊ όǘƘŀǘΩǎ ǘƘŜ modern / touch based one). 

1) Go to the Start Screen 

2) Find the Internet Explorer tile and click to launch 

3) In the URL bar type http://www.java.com and click on “Do I have Java?”.  If you do not have the URL 
bar, right click in any blank space on the screen. 

4) You will receive the following message on the webpage: 

 
5) Within IE, you will receive a notification bar that states “The site java.com uses add-ons that require 

internet explorer on the desktop. 

6)  Click “Open” to open the same web page within IE for the desktop. 

NOTE: This can also be accomplished for any page by clicking the wrench icon next to the 

address bar and selecting “View on Desktop”. 

We may want to control which variation of IE this tile launches for our users to avoid any 

confusion so they can continue to use websites that require Add-ons. While we are in there, we 

can also set how links are opened from other apps. 

1) Access the Start Screen, and type Group Policy Management. The screen will return the icon for 
Group Policy Management Console. With your mouse, click the icon to run. 

http://www.java.com/
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2) Expand the following in Group Policy Management - Forest: ILTA2013.LOCAL > Domains > 
ILTA2013.LOCAL > ILTA2013 Workstations > Windows 8 Desktop Policy 

3) Right Click on Windows 8 Desktop Policy, and select Edit… 

4) When Group Policy Management Editor loads, expand the following: 

a) Windows 8 Desktop Policy > Computer Configuration > Policies > Administrative Templates > 
Windows Components > Internet Explorer > Internet Settings 

5) Double click on Set how links are opened in Internet Explorer and set to Enabled 

6) In the options section, change the list item to Always in Internet Explorer on the Desktop as 
illustrated on the next page. Click OK to set the policy. 

 

 

7) Do the same for Open Internet Explorer tiles on the desktop. 

8) Refresh policy on the machine by right clicking the OU and selecting “Group Policy Update” or by 
opening an administrative command prompt, and type in “gpupdate /force” 

9) Now, go back to the start screen and click the Internet Explorer tile – you will be launched into IE in 
desktop mode, same for when a URL link is clicked from an app -- with full access to all Add-ons that 
are installed. 

 

Finally, despite making the touch version of IE an Add-on-less browser, Microsoft has built in 

support for Adobe Flash. Although flash content is still widely used across the web, it is also a 

common vector by which malware manages to infect Windows systems.  While you are sitting 

around anxiously awaiting for the HTML5 browser-based standards revolution to arrive, maybe 

you would like to be the one person to disable Flash all together? 
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1) Access the Start Screen, and type Group Policy Management. The screen will return the icon for 
Group Policy Management Console. With your mouse, click the icon to run. 

2) Expand the following in Group Policy Management - Forest: ILTA2013.LOCAL > Domains > 
ILTA2013.LOCAL > ILTA2013 Workstations > Windows 8 Desktop Policy 

3) Right Click on Windows 8 Desktop Policy, and select Edit… 

4) When Group Policy Management Editor loads, expand the following:  Windows 8 Desktop Policy > 
Computer Configuration > Policies > Administrative Templates > Windows Components > Internet 
Explorer > Security Features > Add-on Management 

5) Double click on Turn off Adobe Flash in Internet Explorer and prevent applications from using 
Internet Explorer technology to instantiate Flash objects (what a mouthful!), and select Enabled. 

6) Click OK to enforce the setting in Group Policy 

7) Refresh policy on the machine by right clicking the OU and selecting “Group Policy Update” or by 
opening an administrative command prompt, and type in “gpupdate /force” 

8) Now, when any Internet page attempts to access the Flash plugin, with this setting enabled, it will 
be completely blocked from running.   

9) This is what the flash-less revolution will look like! 

  



ILTA HANDS-ON 

ILTA 2013 Windows 8 / Office 2013 Page 19 
 

 

Lab 3: Windows 8 Application Management 

Windows 8 Applications are installed, removed, and managed differently than legacy 

applications.  Most consumers will use the Windows Store to download and install new 

applications.  Enterprises, on the other hand, may need to manage new applications without 

access to the Windows Store, or without going through the Application certification process. 

PowerShell is the primary mechanism for managing Windows 8 applications.  These scriptlets 

can be executed via login script,  SCCM or other similar management platform. 

:  For those users that are running SCCM 2012, Service pack 1 will offer the ability to manage 
Windows 8 applications natively!                                                                                                                                  

In the following lab, we will learn how to install a customized Windows 8 Application that was 

specifically developed for this environment.  Since this application is not available in the Store, 

ǿŜ ǿƛƭƭ ƴŜŜŘ ǘƻ άǎƛŘŜ ƭƻŀŘέ ǘƘŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ƛƴǘƻ ƻǳǊ ²ƛƴŘƻǿǎ у ŜƴǾƛǊƻƴƳŜƴǘ. 

Exercise 1:  Install an d Remove Application s on a per user basis 
Windows 8 applications can be installed or removed on a per user or per computer basis.  A per 

user application is essentially installed in the user profile, making it only available for that user.   

1) Our custom Windows 8 application is located on a network share on our domain controller.  Let’s 
navigate there by going to the Windows Desktop (Windows Key + D), and clicking the File Explorer 
icon from the Taskbar. 

2) In the address bar, type in \ \ HANDS7A-DC\ Windows8  and click Enter to navigate to the share. 

3) Our Windows 8 application is located in the ILTA2013App folder.  To install it, we will need to use a 
PowerShell command.  Launch Powershell by highlighting (left clicking) the ILTA2013 folder, and 
click File => Open Windows PowerShell => Open Windows PowerShell as administrator.  Click Yes 
to get past the security prompt.  This will launch Powershell with the focus on the current directory. 
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4) Type in the following command to load our application: 

add-appxpackage .\ ILTA2013App.appx 

 

The application should now install on for this user. 

5) Go to the Start Screen and then type ILTA. When the ILTA2013App comes up, right click the icon, 
and then select Pin to Start Screen (if it is not already). Type Enter, or click the icon, to run the ILTA 
2013 Sample Application. The first image that presents is a Splash Screen that has mindSHIFT’s logo 
as well as a welcome message. The second screen is the main application that is rather simple. It 
presents the ILTA 2013 logo as well as another small message.  

6) Go back to the Start Screen, either typing the Windows Key or via the Charms. When in the Start 
Screen you will notice that the application has a Live Tile scrolling through the a few messages. 

7) Now we will remove the Games application for this user.   To do so, go back to your powershell 
command, and type in the following: 

  remove-AppxPackage -package Microsoft.XboxLIVEGames_1.0.927.0_x64__8wekyb3d8bbwe 

¶ Hint, we created a specific powershell scripts to do this so you don’t have to type in the entire 
command line.  To run this script, type in .\ Remove-Games.ps1 in the Powershell window. 
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8) The Games application will now be uninstalled and the shortcut removed from this user.  Feel free 
to verify this by going to the start screen. 

 

Exercise 2:  Install and Remove an Application s per  Machine 
If we were to log in as a new user on this machine, the ILTA2013 application will not be 

available.  In order to sideload an application to all new users logging into a machine, it is 

necessary to install the application on per-machine basis.   As new users are logged into the 

machine, their respective profiles will also get a shortcut to the ILTA2013 Sample Application on 

the Start Screen as part of the typical profile creation process.    Additionally, we will remove 

some of the default Microsoft applications to present a more business oriented environment. 

1) Go back to your PowerShell session from the last exercise. 

2) In the session, execute the following line on one line:  

Add-AppxProvisionedPackage -Online -PackagePath .\ ILTA2013App.appx -SkipLicense 

3) Type the Enter key to execute this operation.  This operation will require significantly more time to 
install than adding an application per user.  This step will take  a few minutes to complete.  Feel free 
to go to step 4 while you wait for the following screen: 

 

This line indicates that the application has been added to the machine appropriately. 

4) While this is running, we will also some of the default Microsoft applications.  To do so, go back to 
the file explorer, and navigate to the \ \ hands7a-DC\ Windows8  directory.  Launch Powershell by 
clicking File => Open Windows PowerShell => Open Windows PowerShell as administrator.  Click 
Yes to get past the security prompt.   

5) Type in .\Remove-MetroApps to remove the default Microsoft applications. 

6) We are now ready to check out work by logging in as a brand new user.  Log off of Administrator by 
going to the Start Screen, click Administrator in the upper right, and chose Sign Out from the drop 
down menu that appears. 
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7) Drag the screen up, or double click the picture window to access the log in screen. Chose Other User 
as shown below 

 

8) Enter ILTAUser2 as the user to log in as, and enter “password” as the password to authenticate. Click 
the purple arrow, or type the Enter key to complete the login process as ILTAUser2. Your profile will 
be generated for the first time, so this process may take a few minutes depending on the available 
hardware. 

 

9) Notice that many of the default Microsoft Applications are no longer installed.  The Games 
application, is still there – If you recall, the games application was only removed on a per-user basis, 
so it will still appear for new users logging into the system. 

10) Once at the Start Screen, type the phrase “ILTA” and click the icon, or type the Enter Key, when it 
shows. The new ILTA2013 app will run.  

11) This confirms that the application is installed for All Users, on a per-machine basis 
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12) Jump back to the Start Screen, Click ILTAUser2 in the upper right portion of the screen, and select 
Sign Out from the drop down list.  

13) Log in as Administrator with “password” as the password for the next exercise. 
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Lab 4: Windows 8 Tools 

With Windows 8, the spotlight is on the new Start Screen and the User Interface. However, 

Microsoft also introduces a refreshed Task Manager that is easier to use for both our end users 

and the administrators. Not only does the Task Manager  have an updated look and feel, it also 

shows much more information, such as highlighting the differences between Windows 8 

Applications and Classic Programs and how they are executed.  

Windows 8 also implements the Ribbon menu in File Explorer which not only makes existing 

features easier to access, they offer more commands that improve accessibility to other features 

that were buried in submenus in Windows versions in the past or would need a third party add-

on to access. We touched on it earlier in the previous labs, however, we will now dig deeper into 

the user interface and other available functions that both already existed and are new to 

Windows 8.  

Exercise 1:  Task Manager 
In this exercise, we will review the Task Manager and the updated UI. We will also look at the 

new Heat Map format of the Process Details tab as well as run through Resource Manager.   

1) Log into HANDS7a-Win8 as Administrator and at the Start Screen, you will want to launch the Mail 
App. Do not configure the application when prompted. We just want to keep the application running 
in memory, how it is configured will not have any bearing on the following exercise. 

2) Go ahead and launch Word 2013. We will use this as a comparison further down the line in this 
exercise. There is no need to create a document, as again, it won’t have any bearing on the steps we 
are looking to perform. 

3) Go back to the Start Screen and launch the Task Manager by typing Task Manager, and launching 
the application. 

4) When Task Manager launched, it initially loads in a minimal mode that simply shows applications 
that are running or recently launched. If TaskManager opens in detailed view, you can turn this off 
by clicking “Fewer Details”. The below screenshot might not match all the applications on your VM, 
but still serves the purpose to show how Task Manager looks initially.  
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5) Right click on Mail and select Go to Details in the context menu that pops up. When it does it, you 
will see that the process name running the Mail App is WWAHost.exe. This is the Microsoft 
JavaScript execution engine that runs Windows 8 Applications that are built with JavaScript, which is 
a web based application framework with lightweight extensibility in mind.  

¶ Mail, Bing, Bing Finance, etc., are all based on JavaScript under the covers and all use 
WWAHost.exe to execute.  

6) Right click on Microsoft Word and select Go to Details in the context menu that appears. When it 
does, you will notice the executable is WinWord.exe. Just as any program that is not based on 
JavaScript at its core, they are typically executable on their own and are not launched using an 
intermediary application.  

7) Since we’ve selected Go to Details, you may have noticed that the Task Manager changed into the 
“More Details” mode. This is where we will now investigate the user interface improvements over 
Task Manager from older versions of Windows.  

8) We will now walk through the various tabs in Task Manager.   

a) Process View Tab – Heat map view of currently running processes that are consuming CPU, 
Memory, Disk, and Network. As the resources of each process grow in consumption rate, you 
will see darker shading, allowing you to more easily identify processes that may be consuming 
more resources than normal. This is a vast improvement over the older versions of Task 
Manager. 
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b) Performance View – Gives a quick view of available system hardware and the resource 
utilization for the entire system. You can see the general trend of CPU, Total Physical Memory, 
Disk Read\Write, Network utilization. You’ll also see what type of CPU, the speed it’s running, 
and other advanced system statistics.  

 

c) App History – Heat map view of application performance and consumption over the past 
month. Very useful if troubleshooting performance issues for an end user if they are having 
difficulties with their machines. 

 

d) Startup – Lists processes set to start up automatically in the OS. You can control whether or not 
you still want them to start up, by right clicking on the entry and select Disable.  
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e) Users – Shows current user, or multiple users if configured, and the amount of resources each 
are consuming: 

 

f) Details – Classic Details view of running processes and applications   

 

g) Services – Services status for the current machine 
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Exercise 2:  File (Windows) Explorer  
With File Explorer, we will evaluate the new ribbon menu implemented and take a look at some 

new context menus that are now available easing access to various Windows Features.  

1) While in Desktop Mode, click on the Folder icon in the Task Bar. We saw this when working with 
loading the Windows 8 Application in the previous Lab. When File Explorer first launches, it will give 
you an overview of your profile folders, system and network drives, as well as Home Groups, if any 
are defined. For brevity, we will focus on the UI changes with the new ribbon which is also context 
aware in that it will change available options when you select different options. 

 

2) As you can see, many common features are now readily available in the Computer tab; System 
Properties, Access Media, map network drive, add a network location. Much easier than previous 
version of Windows.   

3) New shortcuts available on Computer tab that were not available in older versions are Control 
Panel, System Properties, Program Management, and Manage. 

4) The View tab with ease of access to View Options such as changing up the Navigation pane, Layout 
view, sorting, and other display settings that change what is displayed.  

 

5) With a folder selected, you will notice more management features are available such as Copy, Paste, 
Cut, and even Copy the current folder path. Other options include easily moving the folder to 
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another location, copy the folder to another location, delete, rename, create new folder, as well as 
easily access folder properties.  

 

6) When click on the File Tab, the following options are available. Open new window, when clicked 
opens the current path in a new window. Handy when you are looking to copy a file or folder from 
one location to another.  

Also, a couple other really handy options are Open Command Prompt or PowerShell prompts. This is 
a really nice shortcut when you need to run a script, it will put you in the proper context if you want 
to launch a batch file or PowerShell script, without needing to worry about the exact folder path to 
change directory.  



 
8024575v.1 

7) When you have a hard drive selected, the Manage tab highlights with Drive Tools as the mode. Here, 
you have access to enable Bit Locker, which is a form of disk encryption. You can also quickly 
optimize the drive (Defragment), Disk Cleanup, Format (Don’t run on C: Drive!).  

If you selected a CD Drive, you would also have AutoPlay, Eject; and, if a CD\DVD writeable drive, 
Finish Burning and Erase this disc.  
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Lab 5: Working With Office 2013 

While Office 2013 is receiving the most attention for its increased presence in the cloud -- 

allowing synchronization of Office application settings and documents between devices using 

SkyDrive and your Microsoft account ς it still has its feet firmly planted on the desktop.  Once 

you get over the decision of whether or not to lease (Office 365) or to buy (Office 2013), you will 

find that Microsoft has made plenty of improvements to its fully boxed, productivity baby. 

The interface is the cleanest yet, integrating nicely into the Windows 8 modern UI by using a 

άŦƭŀǘǘŜƴŜŘέ ǾŜǊǎƛƻƴ ƻŦ ǘƘŜ Ǌƛōōƻƴ ǘhat also keeps the application looking and feeling somewhat 

like previous versions.  New features include a touch friendly read mode in Microsoft Word, 

color coded start screens, support for the latest Strict Open Office XML file format, the ability to 

edit a PDF directly as well as new options in group policy for managing Office and a new VL 

activation model that uses Active Directory instead of KMS or MAK. 

Exercise 1:  Office 2013 Start Screen 
When you first open one of the Office Products, you are greeted by the new Office start screen, 

containing a list of documents that you created on the left, and a series of templates on the 

right. This enhances accessibility to the different templates by making them easily selectable. 

ό5ƻƴΩǘ ƎŜǘ ŀǘǘŀŎƘŜŘΣ ǿŜ ǿƛƭƭ ōŜ disabling this right now) 

1) At Start Screen type Word  

2) When Word initially opens, note the following in the new Office Start Screen: 

¶ On the left hand side of the screen, you will see a list of your Recent Documents 

¶ On the right hand side of the screen you will see the out of the box templates provided for 
Word 2013 

¶ Tucked away below Recent Documents is the option to Open Other Documents that reveals the 
new streamlined browsing interface which keeps track of your recently used folders. 

3) Create a new document by selecting the blank document template from the right hand side of the 
start screen. 

4) Try to type something nice about your current lab partner and click the File tab which will take you 
into the backstage view that was introduced in Office 2010. 

5) Apologize to your lab partner for whatever you wrote and remind yourself that you need to finish 
your book, “How to Give a Compliment” on the flight home.  Oh, and save the file to your 
Documents folder. 
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6) Now Go to File > Info and explore the options available including file properties, Compatibility Mode 
to convert older files up to the new Strict OOXML format, Protect Document & Check Compatibility 
function. 

[ŜǘΩǎ ƴƻǿ ŘƛǎŀōƭŜ ǘƘŜ ǎǘŀǊǘ ǎŎǊŜŜƴ ǎƻ ǳǎŜǊǎ Ŏŀƴ ƎŜǘ ǊƛƎƘǘ ƛƴ ŀƴŘ ǎǘŀǊǘ ǿƻǊƪƛƴƎΦ 

7) Access the Start Screen, and type Group Policy Management. The screen will return the icon for 
Group Policy Management Console. With your mouse, click the icon to run. 

8) Expand the following in Group Policy Management - Forest: ILTA2013.LOCAL > Domains > 
ILTA2013.LOCAL > ILTA2013 Workstations > Windows 8 Desktop Policy 

9) Right Click on Windows 8 Desktop Policy, and select Edit… 

10) When Group Policy Management Editor loads, expand User Configuration > Administrative 
Templates > Microsoft Office 2013 > Miscellaneous 

11) Double click on Disable the Office Start screen for all Office Applications and set to Enabled 

12) Refresh Policy 

13) Word (and other apps) should now launch straight to the editor. 

Exercise 2:  Modifying PDF files in Word 2013  
With Word 2013, edit support for the PDF file format has been incorporated so you can now 

convert a PDF into a Word document and edit the content. 

1) Open the Start Screen and bring up Search. 

2) Select “Files” as the context, enter “.pdf” and click search. 

3) You should find the NewOffice_Datasheet.pdf file 

4) Right click the document and select “Open File Location” as we want to open this within Microsoft 
Word, not the default Microsoft PDF Reader app. 

5) Right click the file, select Open With…, and then chose Word (desktop) from the menu  

6) Word will open the file in Protected View, which we will need to then click enable editing. 

 

7) You will then be presented with the following prompt notifying you that Word will begin converting 
the file over to an editable Word Document. Click OK to accept the prompt and continue 
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8) As you can see, the document still retains its PDF format, but is now opened in Word 2013.  Change 
the text “Introducing Office 2013” to “Introducing Office 15” and click File > Save. 

9) Add “–edited” to the end of the file name to keep the original intact and select “PDF” as the Save As 
Type format. Make sure “Open file after publishing is checked”. 

 

10) Click Save. Word will now capture the changes made to the file, convert to a PDF and pop open the 
new file in the Win 8 reader program. 

N.B. The converted document might not have a perfect page-to-page correspondence with the 
original. For example, lines and pages may break at different locations. 

Exercise 3:  Introducing Sync Slider and Fast Access in Outlook 2013  
Outlook 2013 has introduced two new features to help control the size of OST files in cached 

exchange mode combined with all the instant access of Online mode.  In previous versions, 

Outlook cached all eMail to the local OST file even though recent eMails were the most 

frequently accessed ς with Sync Slider, you control the relative age of eMails that will be 

retained in the offline cache.  Exhchange Fast Access compliments this new feature by providing 

instant access to new eMails when launching Outlook (and as it is synchronizing the offline 

cache), significantly reducing the amount of wait time for your mailbox to get caught up. 

We will get introduced to this setting by taking a look at managing this setting manually, and 

then configuring policy to manage all cached mailboxes.. 

To manually configure the Outlook Sync Slider: 
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1) At the Start Screen, type Outlook and launch – you will be flipped into Desktop mode. 

2) Walk through the following prompts to configure the Outlook Mailbox 

3) Go to File > Info 

 

4) Select Account Settings button > Account Settings submenu option 

5) With the Mailbox selected, click Change 

6) You will see the slider below; you would drag to the left or right to set the timeframe 

7) You can select 1, 3, 6, 12, 24 months, All mail to be available offline. For demonstration purposes 
select 1 month. 
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8) Click Finish and you will be prompted to restart Outlook 

9) Launch Outlook and notice that there are no messages displayed (as there are no eMails in the 
Administrator’s mailbox from the last month). 

 

10) Notice the option to “Click here to view more on Microsoft Exchange” which will grab messages 
older than your sync slider date from the server.  Don’t click this yet – let’s set policy first. 
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N.B. You may need to initiate a search before you can retrieve additional messages. 

 bƻǿ ƭŜǘΩǎ ŎƭƻǎŜ hǳǘƭƻƻƪ ŀƴŘ ŎƻƴŦƛƎǳǊŜ ǇƻƭƛŎȅ ƻƴ ǘƘŜ server to set sync slider settings to one 

month...note this setting will only affect new profiles. 

11) Access the Start Screen, and type Group Policy Management. The screen will return the icon for 
Group Policy Management Console. With your mouse, click the icon to run. 

12) Expand the following in Group Policy Management - Forest: ILTA2013.LOCAL > Domains > 
ILTA2013.LOCAL > ILTA2013 Workstations > Office 2013 Desktop Policy 

13) Right Click on Office 2013 Desktop Policy, and select Edit… 

14) When Group Policy Management Editor loads, expand User Configuration > Policies > 
Administrative Templates > Microsoft Outlook 2013 > Account Settings >  Exchange > Cached 
Exchange Mode 

15) Double click on Cached Exchange Mode Sync Settings and set to Enabled 

16) Change the sync settings to 1 month from the pull down. 
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Exercise 4:  Controlling Outlook Add -ins through Group Policy  
Office 2013 gives desktop administrators new flexibility in managing the add-ins that Outlook 

loads at startup through a simple, pre-defined group policy element.   

²ƘƻΩǎ ōŜŜƴ ƘŜǊŜ ōŜŦƻǊŜΚ 
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[ŜǘΩǎ Ƨǳǎǘ ƎŜǘ ǊƛƎƘǘ ǘƻ ƛǘΦΦΦ 

1) Here are the add-ins that are currently loading with Microsoft Outlook in our Lab. 

 

2) To demonstrate controlling the load behavior of these, we are going to disable all add-ins except 
Lync, Exchange and VBA.  Fire up group policy management once again if you don’t already have it 
open. 

3) Right click Office 2013 Desktop Policy and select “Edit” 

4) Go to User Configuration > Administrative Templates > Microsoft Outlook 2013 > Miscellaneous 

5) Double click List of Managed add-ins and select Enabled. 
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6) Before you click the Show button, notice that the policy explanation describes how to identify the 
syntax to use to identify the add-ins to manage.  Here, we’ve done all the digging around in the 
registry it for you -- so make yours look like ours. 

 

7) Now open Outlook and see how we did (did you feel that? It may have launched a little faster) 
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8)  It’s too early, we’re all tired, but we disabled Lync by accident.  Go back in and change the value for 
Lync from 0 to a 1. Refresh policy and re-launch Outlook to validate. 

 

Or just go home. Thanks for joining us this morning…. 

 


